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NOTE
The screen illustrations in this publication are intended to be 
representations, not exact duplicates of the screen layouts generated 
by the software.

LIMITED WARRANTY
BERNINA International AG warrants for a period of 90 days, 
commencing from the date of delivery of the software to you, that the 
products are free from defects in materials and workmanship. Your 
exclusive remedy for breach of warranty is to return the products 
together with proof of purchase to BERNINA or its authorized dealers 
within the warranty period, and they will be replaced free of charge. You 
are responsible for the cost of shipping and insurance, and bear the risk 
of loss, damage and misplacement of ‘the products’.
The purchaser relies on their own skill and judgment in selecting the 
software for their own use and assumes the entire risk as to the results 
and performance of the software. Subject to warranties and conditions 
imposed by law, BERNINA International AG expressly disclaims all 
other warranties and conditions, whether express or implied, including 
without limitation, warranties and conditions of merchantability, fitness 
for a particular purpose, title and non infringement. BERNINA 
International AG specifically does not warrant that the software will 
meet the purchaser’s requirements or run without interruption or error, 
or appear precisely as described in the accompanying documentation.

LIMITATIONS OF LIABILITY
To the maximum extent permitted by applicable law, in no event will 
BERNINA International AG or its developers, officers, employees or 
affiliates be liable to you for any consequential, incidental, or indirect 
damages (including damages for loss of business profits, business 
interruption, loss of business information and the like), whether 
foreseeable, or unforeseeable, arising out of the use of or inability to 
use the software or accompanying components, and accompanying 
documentation, regardless of the basis of the claim and even if 
BERNINA or an authorized BERNINA representative has been advised 
of the possibility of such damages.
Some states or jurisdictions do not allow the exclusion of incidental, 
consequential or special damages, so the above limitation or exclusion 
may not apply to you.

COMMERCIAL USE OF EMBROIDERY DESIGNS
With the purchase of BERNINA Embroidery Software, BERNINA 
International AG grants the user the commercial use of all included 
embroidery designs (i.e. for sales, advertising, etc.), provided that the 
embroidery design is embroidered on a fabric (or similar). This includes 
all integrated embroidery fonts, but excludes all TrueType fonts and 
trademarks in general, in particular those of BERNINA International AG.
The commercial use of embroidery designs from BERNINA Embroidery 
Software as files in digital form (i.e. individual sale of included 
embroidery designs) is not permitted unless the design file as such has 
been significantly modified. Significant means an obvious modification 
compared to the original embroidery design.

For users using CorelDRAW®, also refer to the End User License 
agreement found under ‘About CorelDRAW SE’.

TERMINATION
Your License to use the BERNINA Embroidery Software is effective as 
long as you comply with the terms and conditions of the License 
Agreement. This License will terminate automatically without notice 
from BERNINA International AG if you fail to comply with any of the 
terms of the License Agreement. You may terminate this License at any 
time by returning the BERNINA Embroidery Software, all copies thereof 
as well as all accompanying documentation and components to 
BERNINA International AG. You will not be entitled to a refund of any 
kind.

CONTACT
If you have any questions, please contact your BERNINA distributor, or 
BERNINA International AG
CH-8266 Steckborn/Switzerland
Tel: (41) 52-762 11 11
Fax: (41) 52-762 16 11

Rev 1 June  2021
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INTRODUCTION

Welcome to BERNINA Embroidery Software 9, the leading embroidery 
design application for home users. This is an MS Windows®-based product 
incorporating many of the conventions with which most PC users are 
already familiar.

First-time users
If you are new to BERNINA Embroidery Software 9, you’ll be pleased with 
its flexible digitizing capabilities, the ease with which you can create and 
edit designs, and how simple it is to add or create your own lettering. 
However, before you begin working with the product, please read Getting 
Started. This chapter presents an overview of the basic concepts of 
digitizing with BERNINA V9 and provides you with important guidelines on 
how to use this software to achieve the best results.
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Update users
BERNINA Embroidery Software 9 is an enhanced version of our earlier 
products. It has many new and expanded features. Please read the Release 
Notes available from the Help menu to quickly familiarize yourself with the 
scope of these improvements.

Note  If you are upgrading from a previous version of the software, you are 
advised not to remove any earlier versions until after installing the new 
software. This gives you the option of merging user-defined settings, 
including user-defined motifs, into the new installation.

System requirements

Before you install the software make sure your computer meets the 
technical system requirements detailed below.

PC specifications
Check that your PC meets the system requirements. Check CPU/RAM as 
well as hard disk space. The table below provides minimum system 
requirements.

Component Minimum Recommended

CPU Intel® Core i3 or AMD Ryzen 3 Intel i5/7 processor or AMD Ryzen 5/7

Operating system Microsoft Windows 10 (64-bit edition) with latest updates

Browser Microsoft Edge or later

Memory 8 GB 16 GB or more

Hard disk size 80 GB 256 GB or more (solid state drive)

Free disk space † 40 GB 60 GB or more

Graphics card Support for Highest Color (32bit) and 
resolution (1366 x 768)

Support for Highest Color (32bit) and 
resolution (1920 x 1080 or higher)

Monitor ¥ 1366 x 768 screen resolution Dual monitors capable of displaying 1920 x 
1080 screen resolution

Mouse USB mouse

USB port Required for data transfer (designs to USB stick) and configure BERNINA WiFi Device.
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Free hard disk space † 
BERNINA V9 occupies up to 5GB of hard disk space, depending on options 
installed. CorelDRAW® SE also takes up an additional 3GB.

Screen resolution ¥

Some controls may be hidden on the user interface if you run your monitor 
at low resolutions. The physical size of your monitor will have a bearing on 
the optimum screen resolution. Larger fonts will exacerbate the problem. If 
you experience visibility issues, try adjusting both screen resolution and 
font size. For example, a resolution of 1600 X 900 with a font size of 100% 
or 125% should be acceptable.

Information for Mac OS X / Apple users
BERNINA V9 can be installed on Intel-based Mac computers using Boot 
Camp to run Windows 10 on a dedicated partition. The use of virtual 
machine software to run Windows within the Mac OS is not supported. A 
partition of at least 85GB is required, 100 GB is recommended.

System security
The software is shipped with a product key which can be found inside the 
software kit. Each product key allows your system to be uniquely identified. 
You will be prompted to enter the product key to register and activate the 
product when the software is launched the first time following installation. 
Please keep the product key in a secure place.
Each licensed copy of the software is for a single user. It entitles you to 
install the product on up to three (3) devices, but you may only run the 
product on one (1) device concurrently. This restriction does not apply to 
BERNINA WiFi Connector which can be run on a second computer at the 
same time as you are running BERNINA V9.

Sound card Required for online video help.

Internet connection Internet connection required to sign in to authenticate BERNINA V9, receive software 
updates and access online content. You can use the software offline provided you 
connect to the Internet at least once every 30 days so that we can validate your 
software license. You will not have all features while working offline.

Component Minimum Recommended
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Note  All computers must use the same login details – email address and 
password. Should you wish to run the software on another computer, you 
must first sign out and ‘release’ the license from the current computer. This 
can be done via the File > Sign Out and Release License command.

Installation

BERNINA Embroidery Software 9 is a 64-bit application. You’ll notice a big 
improvement in speed and performance over the older 32-bit systems. It 
is installed in the 64-bit folder:
C:\Program Files\BERNINA\..

You can, however, still run previous versions of BERNINA Embroidery 
Software on the same computer.

Custom assets

BERNINA Embroidery Software 9 allows you to create files or ‘assets’ of 
various kinds during normal use. The most important of these are of course 
actual embroidery designs. These are located by default in the built-in 
Embroidery Library. 
There are other assets you may create, such as design templates, custom 
motifs and borders. These assets are preserved from installation to 
installation, whether installing a new version of BERNINA V9 or an update 
patch. In order to preserve any custom assets, do not uninstall your 
existing version of BERNINA V9.
If you want to move BERNINA Embroidery Software to another PC, you will 
need to manually transfer any custom assets you have created or received 
from third parties. The folders you are most likely to reference are:
C:\ProgramData\BERNINA\BERNINA Embroidery\BORDERS
C:\ProgramData\BERNINA\BERNINA Embroidery\FONTS
C:\ProgramData\BERNINA\BERNINA Embroidery\MOTIFS
C:\ProgramData\BERNINA\BERNINA Embroidery\STAMPS
C:\ProgramData\BERNINA\BERNINA Embroidery\TEMPLATE
C:\Users\Public\Public Embroidery\BERNINA 9 Embroidery\Mono-
gram Template Designs\Custom
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Make sure these folders are backed up before removing an existing 
installation.

License management

You may have received a 5-part BERNINA V9 product key in the form:
566695e-dedc-4417-a5e7-8326056cd267

This allows you to register an account in order to run BERNINA Embroidery 
Software.

Install the software

Before commencing, make sure you have the following...
 Software product key which is located in the kit.
 If you are updating from V6–V7, you will need your hardware dongle. Do 

not attach until prompted.

 If you are updating from V8, you will be prompted to enter your existing 
product key. If you no longer have it, use the email address that was 
used for registration. If this is no longer known, please contact BERNINA 
Support.

 In addition to the technical system requirements, make sure that:
 Anti-virus is temporally disabled
 You have administrator rights.

https://www.bernina.com/Support/t
https://www.bernina.com/Support/t
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To install the software...
1 Ensure your computer meets the technical requirements for the 

software. See System requirements for details.
2 Close all MS Windows® applications and temporarily disable your 

anti-virus software. 
3 If you have purchased BERNINA V9, uninstall any previous versions of 

CorelDRAW®.
4 Insert the Installation USB Stick in the USB port of your computer and 

wait for the welcome screen. Alternatively, start the installation 
manually by double-clicking the setup.exe on the stick.
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5 Follow the onscreen instructions to complete the installation. You will be 
prompted as follows...

6 Click Install to proceed.
7 If you have purchased BERNINA DesignerPlus, a copy of 

CorelDRAW® SE will be automatically installed, allowing you to take 
advantage of the integrated Artwork Canvas.

Option Details

License 
agreement

Check the license agreement before proceeding. Optionally, 
print the agreement to obtain a hard copy.

Setup type Choose a setup type – complete or custom. If you are updating 
or installing a new copy, choose to install the complete version.

Extra 
languages

The installation will default to the language of your operating 
system. Install additional languages as preferred. These can be 
switched anytime via the BERNINA program group.

Destination 
location

By default, the software will install to the ‘Program Files’ of your 
operating system. Change locations if necessary.



Instal lation 8

Note  If you are installing CorelDRAW® SE, you will need to create Corel 
account or use an existing Corel account in order to activate the 
software.

8 Reboot the PC when prompted. Save any files and close all applications 
beforehand.

9 Double-click the desktop icon to start BERNINA Embroidery Software 9. 
To sign in you will first need to register your account. See Register your 
account for details.
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10 When first running BERNINA DesignerPlus, a CorelDRAW® integration 
message will appear. Choose ‘Install link to CorelDRAW’ to take 
advantage of the integrated Artwork Canvas.

Register your account

You will need to register an account in order to run BERNINA Embroidery 
Software.

Double-click to start BERNINA Embroidery Software.
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To register your account...
1 Double-click the desktop icon to start BERNINA Embroidery Software 9. 

The below ‘sign-in’ screen appears. To sign in you will first need to create 
an account. 

2 Click the ‘Sign up Now’ button and follow the onscreen instructions. An 
internet connection is required for this step. 

Click to sign
up
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You will be prompted to create an account.

3 Fill in the details and click Create. 

Note  When updating your software, use the same email address used 
when registering your V8 software. The system will then automatically 
match the new product key with the old.

Enter account
details

Click to create
account
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You will be prompted to enter additional details.

4 Fill out these details and click the ‘Create Account’ button. The next 
screen is the verification screen. 

Fill in additional
account details

Enter verification
code
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A verification email will be sent to the registered email address.

Tip  If the email does not appear shortly, check the SPAM folder. If 
necessary, click the ‘Send new code’ button.

Copy verification
code
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5 Once received, copy the code in the email – select and press Ctrl+C – 
and paste it into the verification code field.

6 Click the ‘Verify Code’ button. You’ll be prompted to enter the product 
key.

Paste
verification code

Paste or enter
product key
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7 Enter the product key if you have it, and click the ‘Activate Product’ 
button. If you are updating from an earlier version you will be prompted 
to select the current software version you are using. This will only 
happen if the software is not able to detect your existing version.

8 Click to select your current software version. You will be prompted to 
attach your dongle to the PC in order to update.

Select your
current software

version

Attach your
software dongle

to the PC
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Upon successful detection of your current dongle or software key, the 
process will continue automatically. The hardware dongle is deactivated 
and can be discarded following a successful update.

Modify your installation

Whether you are updating your current software or wanting to uninstall it, 
you follow the same procedure. When you re-run the installation program, 
it will automatically detect any existing installation and give you an option 
to modify, repair or remove it. This will prevent installation of more than 
one release on your computer. 

To modify an existing installation...
1 Close all MS Windows® applications but leave Windows running.
2 Insert the Installation USB. 
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3 If the software is already installed on the computer, you will be prompted 
to:

Upon successful installation of the software, the Maintenance 
Complete screen appears.

Periodic updates

Periodically you will receive automatic updates to your software installation. 
These will include improvements and fixes to known problems. If you are 
uncertain about your current status, you can manually check for updates.

To check for updates...
1 Connect your computer to the internet.
2 Start BERNINA Embroidery Software 9. It will automatically check for 

software updates. Alternatively, go the Help menu and choose Check 
for Updates.

If the installation is not up-to-date, you will be prompted to start the 
update. The required file will be downloaded from a secure server.

Option Notes

Modify Change selection of installed components.

Repair Reinstall same components.

Remove Uninstall the software.

Select to check 
for updates
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3 Once download has completed, follow the prompts.
4 Once the update is complete, you will need to restart your PC for 

changes to take effect.

Tip  Automatic updates overwrite your ‘normal’ template. If you have 
made changes, you will need to save them to a custom template – e.g. 
‘My Template’.

Integration with CorelDRAW®

BERNINA DesignerPlus is unique in providing seamless integration with 
CorelDRAW® SE, the most popular vector-based drawing package for home 
users. This features ‘best-of-breed’ bitmap-to-vector tracing, enhanced 
illustration capabilities, photo-editing together with a library of professional 
clipart images.

The integrated Artwork Canvas provides access to all the CorelDRAW® SE 
drawing tools. These offer many techniques for drafting outlines and shapes 
on screen. Vector objects can be converted to embroidery designs. It also 
allows users to create not just embroidery, but true, multi-medium designs. 
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For a description of the tools, use the online help available from the 
Artwork Canvas Help menu. The same menu provides access to Corel 
Video Tutorials and other valuable resources.

Note  CorelDRAW® SE is installed together with Windows .NET Framework. 
Make sure you install it when prompted to do so. It can take up to 20 
minutes or more to install the .NET Framework on some computers.

Hardware setup

Different devices are set up in different ways – some in MS Windows®, via 
the Control Panel, others within BERNINA Embroidery Software 9 itself. For 
instructions on connecting devices to your computer and setting up in 
MS Windows®, see the documentation for the device as well as your 
MS Windows® documentation.

Set up embroidery machines

We recommend using the dedicated BERNINA WiFi Device for cable-free 
communication between computer and machine. The BERNINA WiFi Device 
is provided with most BERNINA V9 products. It can also be purchased 
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separately. The concept behind the BERNINA WiFi Connector network is 
described by the following diagram…

In the above configuration, designs are transfered to BERNINA WiFi Device 
via the main PC running the BERNINA WiFi Connector application. They can 
either be sent directly from the main PC or from a second PC. 

Set up scanners

BERNINA Embroidery Software 9 supports TWAIN-compatible scanners.

Note  Some scanners will not work with BERNINA V9 because they require 
their own scanner software. If this is the case with your scanner, use your 
scanner software for scanning, save the image to your hard drive, then load 
the image into BERNINA V9.

To set up scanners...
1 Connect the scanner using the accompanying instructions.

Embroidery machine 1

Embroidery machine 2

Embroidery machine ‘n’

BERNINA WiFi Connector 
converts design to machine 

file for target machine

WiFi Router

Secondary PC can route
designs through the network

to named BERNINA WiFi
devices

Main PC
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2 Set it up in MS Windows® using the accompanying instructions and/or 
the Microsoft MS Windows® documentation.

3 Start BERNINA Embroidery Software 9.
4 Select Settings > Scanner Setup. The Select Source dialog opens 

displaying a list of scanner drivers loaded on your computer.

5 Select the scanning driver to use, then click Select.

Note  If you have trouble with scanning after re-starting BERNINA 
Embroidery Software 9, there may be a conflict with previously installed 
scanner drivers. Re-install BERNINA V9 and test the scanner. If the 
selected scanner driver does not work in BERNINA V9, select another 
scanner driver from the list. There are usually two installed for each 
scanner.

Screen calibration

The Screen Calibration dialog lets you calibrate your monitor to ensure 
that designs at 1:1 scale display at the actual size of the final embroidery. 

Select
scanning

driver

Measure width

Measure 
height
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Resources & support

BERNINA Embroidery Software 9 provides various ways to access 
information about the software and how to use it. It also provides links to 
sources of ready-made embroidery designs.

Resources

Onscreen documentation is provided in two formats – Online Help and 
Adobe Acrobat. 

Depending on your product level, documentation components will include 
some or all of the following:

Release notes
A set of release notes is included with the software installation. These 
provide detailed information about new and improved features as well as 
direct links to the relevant sections of the Reference Manual.

Reference manual
The Reference Manual provides detailed procedures covering all features of 
the Embroidery Canvas and Embroidery Library. It contains 
step-by-step instructions together with samples and screen images. The 
BERNINA Cross Stitch and BERNINA Quilter applications are documented in 

Access onscreen 
documentation
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supplementary manuals. Copies are available for download via the online 
help main page.

Online help
Online help provides quick access to general information on BERNINA V9 
features and step-by-step instructions. An F1 keypress accesses 
context-sensitive help.

Online resources

There are many other sources of ready-made embroidery designs which 
you can purchase and adapt as you wish. The Embroidery Canvas Help 
menu directs you to two rich sources – Scissortrail Stiches and OESD 
Embroidery design studios.

Note  For a description of the CorelDRAW® tools available in Artwork 
Canvas, refer to the online help available from the Artwork Canvas Help 

Access Scissortrail Stiches 
and OESD Embroidery 
design studios



Resources & support 24

menu. The same menu provides access to Corel Video Tutorials and other 
valuable resources.

Feedback reporter

BERNINA V9 includes a feedback reporter, when connected to the internet, 
to provide direct contact with BERNINA V9 Support following a system 
crash...

Report an issue in the
event of a system

crash
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Use the issue reporter to request assistance for specific issues. The reporter 
can also be run independently from the BERNINA V9 program group.

Conventions used in the manual

The following conventions are adopted and used throughout the manual.

Commands
In this manual, commands on a menu or submenu are referred to by both 
the menu and command names. For example the ‘Dim Artwork’ command 
in the ‘View’ menu is referred to as View > Dim Artwork.

Dialog boxes
Dialog boxes are referred to as ‘dialogs’ and are shown in the manual only 
if they provide important information on using BERNINA Embroidery 
Software. The screen images provided are intended to be representations, 
not exact duplicates of the layouts generated by the software.

Report an issue in the 
event of a system crash
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Keyboard conventions

Instruction Symbol Action

Click [ Click the left mouse button.

Right-click ] Click the right mouse button.

Double-click . Click the left mouse button twice without moving the 
mouse.

Click OK [or j Click OK with the mouse or press the Enter key on the 
keyboard to complete the action.

C + S While holding down the Control key (Ctrl), press the S key 
to save design.
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GETTING STARTED

If you are new to BERNINA 
Embroidery Software or machine 
embroidery, you are probably 
asking yourself ‘where do I start?!’.
It’s safe to say that you will spend 
many hours learning how to get the 
most out of your BERNINA 
embroidery machine and the 
design software which supports it. 
The two work together 
hand-in-hand and it takes practice 
and patience to master both the 
creation and production of fine 
embroidery.
The results, however, will speak for 
themselves, making the time you 
invest all the more valuable. With 
each project you complete, you will 
gain in experience and confidence and be ready to tackle the next 
challenge.
This section outlines the main uses you will make of your BERNINA V9. 
Please refer to the reference manual for more in-depth information.

First things first

You don’t need any experience to start with BERNINA Embroidery Software. 
You can simply open a design and send it to your machine to ‘stitch out’. 
And this is the best place to start. As you gain experience, you will be able 
to ‘read’ designs and identify which are good and which may cause 
problems.
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Sample designs & artwork

BERNINA V9 contains hundreds of ready-to-stitch designs, including many 
attractive ornaments, samples and digitizing backdrops. Design files (ART 
files) and images (BMP, JPG, and WMF files) can be found in your 
Embroidery and Picture libraries.

Note  In order to view Artwork select ‘All Artwork Files’ in ‘Showing’.

Embroidery library

Picture library
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The most valuable thing you can do when starting out as a new user, is to 
spend some time exploring these designs and getting to know what’s 
available.

Note  BERNINA V9 includes its own Embroidery Library design 
management application to view and manage your embroidery designs. 
Alternatively, explore design folders using MS Windows® Explorer.

Other sources

There are many other sources of ready-made embroidery designs which 
you can purchase and adapt as you wish. Your BERNINA V9 directs you to 
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two rich sources – Scissortrail Stiches and OESD Embroidery design 
studios.

Clipart

CorelDRAW® SE gives you access to online content and resources after 
registration. Once registered, clipart and other content can be accessed via 
the program group. It can also be accessed via the built-in CONNECT 
Content docker in Artwork Canvas. Go to Window > Dockers 
> CONNECT Content to open the docker.

Access Scissortrail Stiches 
and OESD Embroidery 
design studios

Access online content 
via the CONNECT 
Content docker



First things f irst 31

Get familiar with the many clipart samples available to you. Many can be 
adapted for use with embroidery design, either as digitizing backdrops or 
direct conversion.

Caution  Included artwork (clipart) and embroidery designs are only 
available for personal use – i.e. they cannot be commercially sold in any 
form.

Rules of good embroidery

Keep the following points in mind when looking at embroidery designs, both 
your own and others:
 Stitches are neat, smooth and even
 Design looks good – shapes, colors, balance
 Shapes are filled with correct fill and outline stitches
 Stitches are angled to match shapes
 Shapes are stitched correctly – no unwanted gaps
 Details are clearly defined
 Lettering is clear and easy to read.
The stitchout should also have the following characteristics:
 The design sews efficiently on the machine
 The fabric does not pucker around stitched areas
 The design is free of loose ends.
Good embroidery quality starts with good design. You then need a good 
quality machine to stitch it out. But even that is not enough if you do not 
use the correct fabric, threads, backings, tension, and so on. Consult your 
machine manual for advice and get as much advice from other 
embroiderers as you can.

Working with embroidery

Before starting, let’s take a look at the scenarios that you will find yourself 
working with. Typically, you will be involved in one or all of the following:
 Take a ready-made design and sew it out
 Make global changes to a design
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 Create a lettering design
 Combine lettering with a design
 Adapt a design by changing parts
 Create new embroidery from artwork using automated techniques
 Create new embroidery manually
 Use special embroidery features 
Let’s look at those cases one by one.

Sew a ready-made design

For many embroiderers, it is enough to take an existing design and stitch 
it out. This is certainly where most will start. Once you have found a design 
you like, you will want to preview it to see how it will sew out. A number of 
steps are involved. We outline the main ones here.

To sew out a design
1 Open the design in BERNINA V9. 

2 Adjust viewing settings as desired. 
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3 Check the fabric type and change as necessary. 
4 Check thread colors and if necessary, change charts to suit the one you 

are using. 
5 Preview the stitchout so you understand how the design will sew on the 

machine. 
6 Choose a hoop and check location within the hoop. 
7 Preview the design and print out a design worksheet before sewing out 

as desired. 
8 Send the design to machine directly or via data media (usually memory 

stick). 

Tip  Check your BERNINA machine documentation for steps involved after 
transferring the design to machine.

Modify an entire design

Once you are used to the steps involved in sewing out designs – either 
clipart or ones you have purchased – you will soon want to make global 
design modifications such as resizing, or changing thread colors and fabric 
types. These are all relatively simple operations.
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To modify an entire design
1 Open the design you want to use. 

2 Check design dimensions, and resize as required.  
For example, if you are stitching a left chest design, maximum size will 
be approximately 4.25" or 108 mm square.

3 Adjust design thread colors as desired. 

4 Alternatively, use the Alt key to ‘suspend’ grouping temporarily. Hold 
and click to select individual objects to recolor. 
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5 Check the fabric type and change as necessary. 
6 Select a hoop of the required size. 
7 Visualize the design on a garment or article. 

8 Print a worksheet and send the design to machine. 

Create a simple lettering design

Once you are used to sewing out designs and resizing, changing colors and 
fabric types, you will definitely want to create your own lettering designs. 
While it takes practice to obtain a good quality lettering stitchout, it is as 
simple as typing letters on-screen to create attractive lettering in 
BERNINA V9.

To create a simple lettering design
 Typically you’ll want to add lettering to an existing design.
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 Add embroidery lettering to designs quickly and easily, either on-screen 
using current settings or via ‘object properties’. 

 It’s then a simple matter to adjust baselines, formatting, spacing 
settings, and colors. 

 Try stitching out your lettering design. Study the stitch quality. Be aware 
that different fonts sew out better at different sizes. 
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Create more advanced lettering

Once you have tried your hand at creating lettering designs and sewing 
them out, you will want to do more adventurous things, such as 
monograms, fancy lettering, flair scripts, raised lettering with trapunto, as 
well as special ‘elastic lettering’ effects. The creative possibilities are 
endless. Your appetite to try new things will be stimulated as you gain 
experience and confidence. Part of that involves becoming adept at using 
your BERNINA machine as well as sampling and checking design quality.

Monogramming

BERNINA V9 makes the creation of monogramming designs quite simple 
with the ‘all-in-one’ Monogramming tool. Optionally include lettering, 
ornaments, and/or up to four concentric borders in your monograms. 

Borders stitched 
first – 1, 2, 3, etc

Ornaments 
stitched next

Lettering 
stitched last
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Fancy fonts

BERNINA V9 includes a number of fancy fonts such as Creative Cross and 
Secret Garden-Caps. These fonts include multiple colors and miniature 
designs. 

Flair script is a special font which allows you to add decorative flairs to the 
end of text objects, mimicking flamboyant handwriting flourishes. 
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Lettering stitch effects

By default, lettering objects are filled with satin stitching. You can apply 
other fill stitch types, such as Step or Fancy, as well as effects such as 
Textured Edge. 

Elastic lettering

Apply ‘elastic lettering’ effects to embroidery lettering to make it bulge or 
arch, stretch or compress. 
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Tip  Remember to study the sample designs included with your 
BERNINA V9 installation. 

Adapt a design

Adapting designs is perhaps the most common scenario in embroidery. You 
will sometimes want to create a new design, usually from artwork, but more 
often you will want to take an existing design and ‘re-purpose’ it. We’ve 
already seen how to make global changes such as sizing, changing colors 
and fabrics. It won’t be long before you want to try more ‘invasive’ changes 
such as reshaping, removing, combining, duplicating, resequencing, 
changing stitch types and effects, etc. Here is a sampling of the things you 
may want to try.

Combine designs

One technique you will undoubtedly use is combining design elements. This 
will in turn teach you a lot about other editing operations such as resizing, 
positioning, rotating, sequencing objects, as well as removing underlying 
stitching. 
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Transform design elements

Depending on the type of design work you are doing, you can make use of 
BERNINA V9 tools for duplicating, rotating, and mirroring design elements 
to create wreathes, kaleidoscopes, and other effects. 

Reshape elements

Reshaping operations may be called on for anything from minor 
modifications to object shapes to reshaping letters for special effects. In all 
cases, if it is selectable, it can be reshaped. 
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Apply artistic stitch effects

It won’t take long before you get bored with simple fills and outlines and 
want to try out some of the many artistic stitch types and effects 
BERNINA V9 provides. 

Tip  Remember to study the sample designs included with your 
BERNINA V9 installation.

Create ‘automatic embroidery’

If you have graduated this far in your exploration of your BERNINA machine 
and BERNINA V9, you are doing well. You can already achieve a great deal 
without having to actually do your own design or digitizing work. However, 
if you have graduated this far, that is probably exactly what you want to do!
One of the quickest ways to get started is to use the automated techniques 
BERNINA V9 provides. While there are limitations to what can be done this 
way, it nevertheless allows you to prototype design ideas relatively simply 
and may be sufficient for your purposes. At least for now!



Create ‘automatic embroidery’ 43

Vector artwork conversion

Special conversion tools in BERNINA V9 automatically convert vector 
objects and text to embroidery or lettering objects. These can be modified 
as required. 

Tip  A good starting point is to use some of the many clipart samples 
packaged with CorelDRAW®. Many of these can be adapted for use in 
embroidery design.

Bitmap artwork conversion

The Magic Wand tool provides everything necessary to digitize shapes in 
bitmap images automatically. An extension of this technology, 
Auto-Digitize recognizes shapes in artwork and makes decisions about 
the most suitable stitch types to use. 
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Photographic conversion

Use the powerful Color PhotoStitch tool to create embroidery from 
photographs and other images. 

Create new embroidery from scratch

If you have reached this point, you have already mastered 90% of the 
techniques that most embroiderers need. However, coming to grips with 
the ‘black art’ of manual digitizing is the next step in becoming an 
embroidery master. But you don’t have to dive off the deep end. You can 
start with quite simple projects and work your way up to more complicated 
designs with more complicated stitch effects.



Create new embroidery from scratch 45

Start with good artwork

To create good quality embroidery, you need to choose suitable artwork for 
use as a digitizing backdrop. Unless you are an experienced digitizer, don’t 
use complicated artwork.

Artwork that is not in digital format needs to be scanned. This can be done 
via CorelDRAW® which is included with BERNINA DesignerPlus. Possible 
sources include:
 books
 internet or CD clipart
 children’s art
 your own original artwork.
And remember that a good starting point can be found with some of the 
many clipart samples packaged with CorelDRAW®. Many of these can be 
adapted as ‘digitizing backdrops’.

Prepare your artwork

Before digitizing, you need to analyze and plan design shapes and stitching 
sequence carefully. Design shapes need to be clearly defined to make them 
easy to embroider. The easiest shapes to embroider have a relatively 

Scanned in 256 
color mode

Scanned in RGB 
color mode 
(millions of colors)
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constant width, with smooth edges, no sharp turns and no small, 
protruding details. 

Digitize your design

In BERNINA V9, you build designs from basic shapes or ‘embroidery 
objects’. The process of creating embroidery objects on-screen is called 
‘digitizing’. 

As with creating designs in graphics applications, embroidery digitizing 
involves the use of different tools or methods. These are used in 
conjunction with stitch types to create embroidery objects. 

Simplify edges in artwork
before or during digitizing

1

2

3
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Choose stitch types

Decide which stitch types you will use for each design shape. BERNINA V9 
lets you change them at any stage. 

Sequence your design elements

Design sequence is the order in which objects are created and therefore in 
which they are stitched out. You can change the object sequence to 
improve sewing – for example, to minimize color changes. Details should 
be stitched last. 

Improve stitch quality

Through trial and error you will get a feel for the issues that affect stitch 
quality. BERNINA V9 automates many of the quality issues such as stitch 

6 color changes 4 color changes
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bunching, push-pull effect, and embroidery stability. This single most 
important setting in this regard is choice of fabric type. 

Other factors come into play such as choice of underlay type. 

Pull compensation is the other stitch quality setting which you may have to 
consider, although default settings are generally sufficient. 

Woven Medium Weight Woven Heavy Weight

Zigzag underlay

Edge Walk 
underlay

Pull compensation

Digitized outline Calculated outline
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Use special embroidery features

Once you have mastered manual digitizing, you are in a position to take 
advantage of the full range of stitch types and effects that BERNINA V9 
offers. Many of them you will be familiar with, having already adapted 
existing designs for different purposes. 

Freehand embroidery

Some of them, like Freehand Embroidery, cannot be applied to existing 
objects but must be digitized from scratch. This is a technique that lets you 
create designs with a hand-drawn appearance, something which is difficult 
to achieve through conventional digitizing methods. The aim is to mimic 
designs formed on an embroidery machine by freehand motion. The 
difference is that the fabric secured in an embroidery hoop, allowing the 
needle to ‘draw’ on the fabric surface, exactly as you have drawn 
on-screen. 

Patterned stamps, runs & fills

Patterns are predefined design elements, such as hearts, leaves or border 
patterns, that can be quickly inserted into a design. They generally consist 
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of one or more simple objects, and are stored in a special pattern set. Use 
them to create patterned borders or fills, or use them standalone. 

Craft stitch borders & fills

BERNINA V9 provides a range of craft stitches which you can use to mimic 
some traditional hand-worked embroidery. They include a large range of 
blackwork and candlewicking patterns suitable for both outlines and fills. 
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Appliqué

Appliqué is an important craft in home sewing, and the Digitize Appliqué 
feature provides an easy way to create quality work. Use it to generate the 
stitching you require for closed-object appliqué. 

Cross stitching

Cross stitching is a popular technique for filling large areas with low stitch 
counts. It can also be used for outlines and borders. It is suitable for 
homeware, tablecloths, children’s clothes and folk designs. Cross stitch is 
sometimes combined with appliqué. The BERNINA Cross Stitch application 
lets you create dedicated cross stitch designs or add cross stitching to 
embroidery. 

Quilting

Patchwork is a popular technique for designing and sewing patches into 
blocks. BERNINA Quilter can be used to design patchwork quilts, either 
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from existing designs or patterns, or from designs of your own making. Use 
BERNINA Quilter to experiment with patches and colors enabling you to 
create beautiful, personalized quilts. 

Embroidery quilting

Quilted embroidery creates dimension by stuffing or filling areas to produce 
a raised surface. It employs a technique known as ‘trapunto’, also referred 
to as ‘stuffed embroidery’. Using Layout tools, it’s a simple matter to define 
quilt blocks of specified size. You can then arrange elements around the 
block, with or without a central design element. 
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Buttonholing

BERNINA V9 allows you to insert preset buttonholes, either singly or in a 
line. You can specify their size and merge them into a design. 

Multi-decoration

With the inclusion of CorelDRAW®, BERNINA V9 supports multi-medium 
design. A popular technique is to combine digital print with embroidery to 
create multi-decoration work. This is intended to be both digitally printed 
and embroidered.

Typically, transfer paper is used together with a normal color printer. 
Images are reversed during printing and the transfer then ironed onto the 
garment. Check the available options and use one that lets you reverse the 
image.
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Raised embroidery

Finally, if you have exhausted all the techniques outlined above, or if you 
have a particular interest in fiber-arts crafts, you may be tempted to lift 
your embroidery right off the canvas so to speak, and venture into raised 
or ‘sculpted’ surfaces. Thankfully BERNINA V9 provides some smart 
methods to make this easier for you to achieve. 

Happy embroidery!

Do good work with your BERNINA machine and BERNINA V9. With this 
equipment you have everything you need to create top quality, fully 
professional embroidery. The only thing you lack is the capacity to mass 
produce!
Remember that Rome wasn’t built in a day. It takes practice and patience 
to master all the techniques and approaches outlined above. But the results 
will more than reward the time you invest in the fascinating art and craft of 
embroidery decoration.
Remember to make good use of the packaged designs and clipart. When in 
doubt, go back to first principles. And when you find you want to expand 
and extend your repertoire, study the sample designs carefully to see how 
it’s done. 
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As a final word of advice, try stitching out sample designs before you 
embark on your own creations. This will alert you to the key issues to 
consider when doing your own work.
All the best. And have fun!
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QUICK REFERENCE

This Quick Reference outlines the operating modes of BERNINA Embroidery 
Software and summarizes commands and tools available in Embroidery 
Canvas and Embroidery Library.

Operating modes

BERNINA Embroidery Software has one 
workspace but you interact with it in different 
modes or ‘canvases’ – Home, Artwork 
Canvas, Embroidery Canvas, or 
Embroidery Library. These are accessed via 
the Canvas toolbar.

Tip  The Options dialog allows you to set the 
default start screen – usually the Home 
screen. Alternatively, you may prefer to display 
either the Embroidery Canvas or 
Embroidery Library on startup.

Home screen

The Home screen loads by default when 
BERNINA V9 starts. It offers quick access to 
recently opened designs as well as content 
such as tutorials, project ideas, blog postings, 
and much more.

Click Canvas > Home to return to the Home 
screen to get started with a new design, or 
access tutorials and other product information.
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In a nutshell, the Home screen provides...

Tip  You can deactivate the Home screen from 
running on startup via the Options dialog.

Embroidery library

The built-in Embroidery Library provides an 
efficient way to view and manage embroidery 
designs. It recognizes all design file formats 
used by the software. The library also makes it 
easy to search, sort and browse all embroidery 
designs on your system.

Feature Benefits

Quick access 
to software 
features

• Links to Embroidery Canvas
• Links to the Embroidery Library

Home page Quick access to...
• Blank design or ‘canvas’
• Existing files from hard drive
• Recently opened design files.

Tutorials Libraries of lessons prepared by 
BERNINA Embroidery Software 
experts.

Skill builder Quick access to...
• Project ideas for your embroidery 

machine
• Embroidery projects for beginners 

and experts
• Free downloads, instructions and 

much more
• Tips and tricks to facilitate 

embroidering.

BERNINA 
blog

Regularly updated content including 
tips, tricks, ideas and freebies.

BERNINA 
webinars

Informative online webinars, both 
realtime as well as prerecorded.

Embroidery 
designs shop

New designs are released each 
week. Shop by theme, technique or 
brand.

Use Canvas > Embroidery Library to view and 
manage all embroidery designs and artwork 
on your system.
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In a nutshell, Embroidery Library lets you:
 Find embroidery designs anywhere on your 

hard drive or external storage device and, 
optionally, add them to your embroidery 
library. 

 Search for designs by various means, 
including known design information.

 Create an organizing structure for easy 
categorization.

 Batch-convert selected design files to many 
machine formats such as EXP, DST, SEW, 
and others.

 Print selected designs or send them to 
embroidery machine for stitchout.

Artwork Canvas

BERNINA DesignerPlus integrates with 
CorelDRAW® SE into a single application. The 
Artwork Canvas allows you to create and edit 
bitmap and vector artwork using the 
CorelDRAW® SE toolbox. Below is a screen 
image of the Artwork Canvas workspace. This 
includes the entire suite of CorelDRAW® 

View (Manage
Designs) toolbar

Manage Designs
toolbox

Virtual Embroidery
Library folder

structure

Design display

Preview panel

Use Canvas > Artwork Canvas to import, edit 
or create vector artwork as a backdrop for 
embroidery digitizing, manual or automatic.
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drawing tools which offer many techniques for 
drafting outlines and shapes onscreen.

In addition, Artwork Canvas provides 
capabilities to convert vectors and vector text 
directly to embroidery. You can use Artwork 
Canvas to insert or paste third-party vector 
graphics such as clipart for use in embroidery 
designs. Alternatively, insert, paste or scan 
bitmap artwork for use as digitizing templates 
or ‘backdrops’.

Note  For a full description of the CorelDRAW® 
tools, refer to the product information available 
from the Artwork Canvas Help menu.

Embroidery Canvas

The Embroidery Canvas allows you to create, 
edit, and output embroidery designs. The 

Docker panel

Workspace

Canvas toolbar

Toolbox

Artwork toolbar

Use Canvas > Embroidery Canvas to digitize 
and edit embroidery designs. Display 
embroidery as well as artwork. View designs 
realistically in 3D simulation.
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screen image below displays an exploded view 
of all toolbars in the Embroidery Canvas.

Embroidery Canvas menus

The Embroidery Canvas menu bar contains 
the pulldown menus described below.

Note  Standard MS Windows® Alt key 
shortcuts apply. Use the Alt key with the letter 
underlined in the menu. To cancel an operation, 
press Esc twice.

File menu

Docker panel

Workspace

Menu bar

Toolboxes

Title bar

Color palette

View toolbar

 Stitches toolbar

Canvas toolbar

General toolbar

Zoom and
Travel toolbars

Transform toolbar

Status bar

 Effects toolbar

New Open new blank design. Shortcut 
<Ctrl>+<N>.

New from 
Template

Create new design from template. 

Open Design Open an existing design. Shortcut 
<Ctrl>+<O>.

Open Recent 
Design

Open a design from the most 
recently used.
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Edit menu

Open Backup 
Design

Open directly onto the backup folder 
for quick access to backup files in 
case of software failure.

Close Close current design.

Save Save current design. Shortcut 
<Ctrl>+<S>.

Save As Save current design with a different 
name, location or format.

Save as 
Template

Save current design as a design 
template for future use.

Export 
Machine File

Convert current design to a 
machine-readable format.

Export 
Cutting File

Export object shapes to SVG or EXP 
file for cutting machine or BERNINA 
embroidery machine with the 
CutWork tool.

Print Print design using current settings. 
Shortcut <Ctrl>+<P>.

Print Preview Preview design worksheet for the 
current design.

Read from 
Card / 
Machine

Read (open) design from 
BERNINA V9 Design Card or 
BERNINA embroidery machine.

Write to Card 
/ Machine

Write (save) design to BERNINA 
design card or BERNINA embroidery 
machine.

Read from 
BERNINA 
WiFi Device

Receive designs from a named 
BERNINA WiFi Device.

Send to 
BERNINA 
WiFi Device

Send the current design to a named 
BERNINA WiFi Device.

Insert 
Embroidery

Import embroidery design files into 
the current design.

Insert Artwork Import vector or bitmap artwork into 
current design as a backdrop for 
manual or automatic digitizing.

Scan Artwork Scan images directly into 
BERNINA V9.

Save Design 
As Bitmap

Save design images in Stitch View or 
Artistic View. The resulting image is 
exactly as it appears in the 
workspace.

Sign Out and 
Release 
License

Each licensed copy of the software is 
for a single user. It entitles you to 
install the product on up to three (3) 
devices. But you may only run the 
product on one (1) device 
concurrently.

Exit Close all open designs and exit 
BERNINA V9. Shortcut <Alt>+<F4>.

Undo / Redo Cancel last command or series of 
commands, or re-apply. Shortcuts 
<Ctrl>+<Z>/<Y>.

Cut / Copy Cut or copy selection and place on 
Clipboard. Shortcuts 
<Ctrl>+<X>/<C>.

Paste Paste contents of Clipboard into 
workspace. Shortcut <Ctrl>+<V>.

Duplicate Duplicate selection without placing it 
on Clipboard. Shortcut <Ctrl>+<D>.

Duplicate with 
Offset

Duplicate object at a preset offset 
from the source object. Shortcut 
<Ctrl>+<Shift>+<D>.

Delete Delete selection without placing it on 
clipboard. Shortcut <Del>.
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View menu

Select All Select all objects in design. Shortcut 
<Ctrl>+<A>.

Deselect All Deselect all selected objects in 
design. Shortcut <X>.

Close Curve 
with ... Line

Close an open outline with a straight 
or curved line.

Smooth 
Curves

Apply curve ‘smoothing’ to selected 
objects.

Elastic 
Lettering

Apply special effects to lettering 
objects to make them bulge or arch, 
stretch or compress.

Adjust Stitch 
Spacing

Change stitch density across whole 
or selected parts of a design.

Artistic View Show/hide artistic view. Shortcut 
<T>.

Dim Artwork Dim backdrops to show stitches 
more clearly when digitizing.

Show > ... Access same design viewing 
commands as available on View 
toolbar. See View toolbar for details.

Show Hoop Show/hide hoop display.

Show Hoop 
Template

Show hoop template as an 
alternative to grid lines, in order to 
align design at correct location and 
orientation.

Show Grid Show/hide workspace grid. 

Show Rulers & 
Guides

Show/hide workspace rulers and 
guides.

Show Work 
Area

Show/hide work area defined under 
Layout.

Show Quilt 
Block

Show/hide quilt block defined under 
Layout. 

Zoom > Zoom Zoom in/out of workspace and zoom 
in on bounded areas to full window 
size. Shortcut <B>.

Zoom > 
Zoom 1:1

Show design at actual size. 
Shortcut <1>.

Zoom > Zoom 
Factor

Display design as a factor of actual 
size – e.g. ‘1.5’. Shortcut <F>.

Zoom > Zoom 
In 1.25x

Increase view by a factor of 1.25. 
Shortcut <+>.

Zoom > Zoom 
Out 1.25x

Decrease view by a factor of 1.25. 
Shortcut <->.

Zoom > Zoom 
In 2X

Display design at 200% current 
view. Shortcut <Z>.

Zoom > Zoom 
Out 2X

Display design at 50% current view. 
Shortcut <Shift>+<Z>.

Zoom > Zoom 
to Fit

Fit whole design in workspace. 
Shortcut <0>.

Zoom > Zoom 
to Selected

Fit selected objects in workspace. 
Shortcut <Shift>+<0>.

Zoom > Zoom 
to Article

Fit entire article in workspace.

Zoom > Zoom 
to Hoop

Fit entire hoop in workspace.

Pan Pan across the workspace by 
dragging. Useful at high zoom 
factors. Shortcut <P>.

Previous View Return to previous view. Shortcut 
<V>.

Center Current 
Stitch

Center current stitch cursor position 
in workspace. Shortcut <C>.

Measure Measure distances and angles on 
screen. Shortcut <M>.

Stitch Player Simulate stitchout to check stitching 
sequence. Shortcut <Shift>+<R>.
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Design menu

Arrange menu

Artwork menu

Settings menu

View by Color Show only selected colors in 
design.

View all Colors
Show all colors after using the View 
by Color dialog.

Refresh 
Screen

Refresh screen display. Shortcut 
<R>.

Design 
Properties

Show design information such as 
size or number of stitches, and 
add comments to print on 
worksheet.

Thread Colors Search for and match threads from 
different charts, and assign for 
use.

Auto Start & End Set start and end needle positions 
in design.

Fabric Adjust fabric types and settings.

Background and 
Display Colors

Adjust design background and 
display colors.

Optimize Color 
Changes

Automatically resequence objects 
to reduce number of color 
changes.

Remove Small 
Stitches

Automatically remove unwanted 
small stitches.

Group Combine multiple objects into one 
selectable object grouping. Shortcut 
<Ctrl>+<G>.

Ungroup Split object grouping into component 
objects. Shortcut <Ctrl>+<U>.

Lock / Unlock 
All

Lock and unlock objects to protect 
them during digitizing or editing. 
Shortcut keys <K> and <Shift>+<K>.

Sequence > 
...

Access same object sequencing 
commands as available on Color 
Film toolbar. See Color Film toolbar 
for details.

Align > ... Same functions as the Arrange 
toolbox. See Arrange toolbox for 
details.

Space Evenly 
> ...

Insert Artwork Same as File > Insert Artwork.

Adjust Bitmap Adjust image effects, brightness 
and contrast in preparation for 
auto-digitizing.

Touch Up Open a third-party paint program to 
edit selected bitmap artwork.

Crop > ... Crop bitmap artwork for use with 
auto-digitizing. 

Bitmap Artwork 
Preparation

Reduce number of colors, remove 
image ‘noise’, and sharpen 
outlines in imported artwork.

Object 
Properties

Same functions as the General 
toolbar. See General toolbar for 
details.Effects

Options Adjust settings for display window.

Manage Fabrics Manage custom fabrics for special 
needs.

Calibrate 
Screen

Calibrate screen for accurate 
display.
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Window menu

Help menu

Embroidery Canvas toolbars

The Embroidery Canvas workspace contains 
the toolbars described below. Not all tools are 
relevant to all levels of product.

Canvas toolbar

The various operating modes in BERNINA V9 
are accessed via the Canvas toolbar.

Scanner Setup Set scanner options.

Create Pattern Save your own patterns for future 
use in pattern fills or runs, or even 
as pattern stamps.

Create Border Save your own borders for future 
use with monogram designs.

Tile 
Horizontal / 
Vertical

Split open design tabs in a 
horizontally or vertically ‘tiled’ 
(non-overlapping) fashion.

Remove 
Tiling

Remove tiled tab windows and return 
to a single workspace.

Dockers > ... Show/hide dockers to optimize 
working area. See also General 
toolbar.

Toolbars > ... Show/hide toolbars to optimize 
working area.

(Title of Open 
Window)

Choose from a list of open windows 
titles in the order in which they are 
stacked.

Help Topics List onscreen help topics.

Reference 
Manual

Onscreen documentation in Adobe 
Acrobat PDF format. Note: 
depending on your product level, 
documentation components may 
vary.

Release 
Notes

Home Screen Return to the Home screen to get 
started with a new design, or access 
tutorials and other product 
information

Check for 
Updates

As long as you maintain Internet 
access, software updates are 
automatically checked. Use this to 
prompt a manual check.

About Show BERNINA V9 version 
information.

Show Design 
Warning

Display a warning when opening a 
design that should not be scaled.

Other Links are provided to product 
information, tutorials, and rich 
sources for embroidery designs.

Home

Return to the Home screen to 
get started with a new design, 
or access tutorials and other 
product information.
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Note  For a full description of the 
CorelDRAW® SE tools, refer to the onscreen 
help available from the Artwork Canvas Help 
menu.

General toolbar

This toolbar includes tools for opening and 
outputting designs, accessing design 

properties, and opening and closing docker 
windows.Artwork 

Canvas

Import, edit or create vector 
artwork as a backdrop for 
embroidery digitizing, manual 
or automatic.

Embroidery 
Canvas

Digitize and edit embroidery 
designs. Display embroidery as 
well as artwork. View designs 
realistically in 3D simulation.

Embroidery 
Library

Open the Embroidery Library 
window. 

Show 
Embroidery

Show/hide any embroidery 
components. Only available in 
Artwork Canvas.

Convert selected embroidery 
objects to artwork. Only 
available in Embroidery 
Canvas.

Convert selected graphics to fill 
or outline stitches. Only 
available in Artwork Canvas.

New Blank 
Design

Create a blank design. Shortcut 
<Ctrl>+<N>.

Open Design
Open an existing design. 
Shortcut <Ctrl>+<O>.

Open Recent 
Designs

Open a design from the most 
recently used.

Save Design
Save current design. Shortcut 
<Ctrl>+<S>.

Print
Print active design using current 
settings.

Print Preview
Preview design worksheet for 
the current design.

Write to Card 
/ Machine

Write (save) design to 
BERNINA design card or 
BERNINA embroidery machine.

Send to 
BERNINA 
WiFi Device

Send the current design to a 
named BERNINA WiFi Device.

Cut
Cut selection and place on 
Clipboard. Shortcut 
<Ctrl>+<X>.

Copy
Copy selection and place on 
Clipboard. Shortcut 
<Ctrl>+<C>.

Paste
Paste contents of Clipboard into 
workspace. Shortcut 
<Ctrl>+<V>.

Undo
Cancel last command or series 
of commands. Shortcut 
<Ctrl>+<Z>.
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View toolbar

This toolbar brings together tools for design 
visualization. 

Redo
Re-apply last command or 
series of commands. Shortcut 
<Ctrl>+<Y>.

Insert 
Embroidery

Same as File > Insert 
Embroidery.

Insert 
Artwork

Same as File > Insert Artwork.

Object 
Properties

Access properties of selected 
embroidery objects or preset 
with nothing selected.

Effects
Apply stitch effects to selected 
embroidery objects or preset 
with nothing selected.

Options
Access workspace options such 
as grid, hoop, and scroll 
settings.

Change measurement units 
within software without 
changing operating system 
settings.

Overview 
Window

Show/hide Overview Window 
docker. Use to zoom and pan 
thumbnail of current design.

Color Film
Show/hide Color Film docker. 
Use it to resequence objects 
and color blocks in the design.

Carving 
Stamp

Show/hide Carving Stamp 
docker. Use preset or custom 
patterns to create a pattern of 
needle penetrations.

Morphing 
Effect

Show/hide Morphing Effect 
docker. Create transformed 
object outlines and stitches.

CutWork 
Border

Show/hide CutWork Border 
docker. Use in conjunction with 
CutWork and StumpWork 
toolboxes.

Show Artistic 
View

Show/hide simulation of 
stitched embroidery. Shortcut 
<T>.

Dim Artwork
Dim backdrops to show stitches 
more clearly when digitizing.

Show 
Stitches

Show/hide embroidery 
stitching. Shortcut <S>.

Show 
Outlines

Show/hide object outlines. Turn 
off stitches to view outlines only. 
Shortcut <L>.

Show Needle 
Points

Show/hide the needle points in 
embroidery stitching. Shortcut 
<.> (period).

Show 
Connectors

Show/hide connecting stitches 
between embroidery objects. 
Shortcut <Shift>+<C>.

Show Bitmap 
Artwork

Show/hide any bitmap artwork 
included in the design. Shortcut 
<D>.

Show Vector 
Artwork

Show/hide any vector artwork 
included in the design such as 

CorelDRAW® clipart. Shortcut 
<Shift>+<D>.
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Color Palette toolbar

This toolbar displays a palette of thread colors 
together with tools for selecting, applying, and 
cycling through colors. 

Stitches toolbar

This toolbar provides a range of basic outline 
and fill stitch types as well as those of a more 
artistic or decorative kind. It also includes stitch 
effects which can be additionally applied. 
Left-click icons to select stitch type. Right-click 
to access properties. 
 

Show 
StumpWork

Show/hide any stumpwork 
sub-designs included in the 
design.

Show 
Appliqué 
Fabric

Show/hide fabric / color of any 
appliqué objects in the design.

Show Hoop
Show/hide hoop. Right-click for 
settings.

Show Hoop 
Template

Show/hide hoop template.

Show Grid
Show/hide workspace grid. 
Right-click for settings.

Show Rulers 
& Guides

Show/hide workspace rulers 
and guides. Right-click for 
settings.

Show Work 
Area

Left-click to toggle work area 
display. Right-click to open 
Define Work Area dialog.

Show Quilt 
Block

Left-click to toggle quilt block 
display. Right-click to open 
Define Quilt Block dialog.

Stitch Player
Simulate stitchout to check 
stitching sequence. Shortcut 
<Shift>+<R>. 

Color Picker
Pick up a color from an existing 
object and make it current.

Apply 
Current 
Color

Apply the currently selected 
palette color to embroidery 
objects.

Current 
Color

Shows the currently selected 
palette color.

Add Palette 
Color

Add a color slot to the end of the 
palette.

Remove 
Palette Color

Removed an unused color slot 
from the end of the palette.

Hide Unused 
Colors

Show/hide all unused colors in 
the palette.

Discard 
Unused 
Colors

Remove all unused colors from 
the palette.

Cycle Used 
Colors

Cycle through combinations of 
used colors. Right- or left-click.

Color Wheel
Access Color Wheel to test 
combinations of related colors.

Threads
Search for and match threads 
from different charts, and assign 
for use.

Outlines

Single Outline

Create a single row of 
stitches along a digitized 
line. Use for outlines and 
details.
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Triple Outline

Create a thicker outline by 
repeating each stitch three 
times – use for heavier 
borders or details.

Sculpture Run 
Outline

Create a thick-thin outline 
alternating single and triple 
stitches for a hand-stitched 
look.

Backstitch 
Outline

Create traditional backstitch 
borders – old, adaptable 
stitch type used for delicate 
outlines.

Stemstitch 
Outline

Create traditional stemstitch 
borders or details such as 
stems and vines.

Zigzag Outline
Create narrow, open borders 
with a ‘zigzag’ effect.

Satin Outline
Create thicker borders or 
columns of even thickness.

Raised Satin 
Outline

Create raised satin borders 
– can be used with trapunto 
for quilting effects.

Blanket Outline
Create narrow, open borders 
with a ‘comb’ effect.

Blackwork 
Outline

Create ornamental 
craftstitch borders. Name 
derives from black silk 
thread traditionally used in 
this form of embroidery.

Candlewicking 
Outline

Create ornamental 
craftstitch borders. Specify 
exact pattern size and 
spacing.

Pattern Run 
Outline

Create ornamental 
craftstitch borders. Choose 
from pattern library.

Fills

Step Fill
Create stitch fills for larger, 
irregular shapes.

Satin Fill
Create stitch fills for narrow 
shapes.

Raised Satin Fill

Create raised surfaces – can 
be applied to lettering or 
used with trapunto for 
quilting effects.

Fancy Fill
Create artistic fills while 
keeping the appearance of 
solid stitching.

Sculptured 
Fancy Fill

Create 3D pattern effects 
with turning fills.

Ripple Fill
Create spiral stitching from 
the center of any filled 
object.

Contour Fill

Create stitching which 
follows object contours, 
creating a curved, 
light-and-shade effect.

Blackwork Fill

Create fill for blackwork 
designs. Name derives from 
black silk thread traditionally 
used in this form of 
embroidery.

Candlewicking 
Fill

Create candlewicking fills – 
traditional white-on-white 
embroidery usually done 
with heavy cotton thread on 
white linen.

Lacework Fill
Create a lacey look with 
open trellis-like patterns.
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Effects toolbar

This toolbar contains tools used to create many 
artistic effects to create textured and curved 
stitching, and warping or ‘morphing’ stitching 
effects. 

Transform toolbar

This toolbar contains all the tools you need to 
select, reshape, scale, mirror designs, and 
rotate hoops in Embroidery Canvas. 

Pattern Fill
Create decorative fill 
stitching. Choose from 
pattern library.

Cross Stitch Fill

Create open patterned fills 
with crosses generated to 
suit standard grid for entire 
design. 

Stipple Run Fill
Create fills made up of run 
stitches which meander 
within a border.

Stipple 
Stemstitch Fill

Create heavier stipple run 
fills with stemstitch outlines.

Stipple 
Backstitch Fill

Create heavier stipple run 
fills with backstitch outlines.

Underlay
Strengthen and stabilize objects 
with underlay stitching.

Textured 
Edge

Create rough edges and 
shading effects, or imitate fluffy 
textures.

Automatic 
Corners

Toggle mitre or cap corners in 
line objects with sharp turns. 
Can be turned on/off 
object-by-object.

Couching
Add couching cord for use with 
the BERNINA Free Motion 
Couching Foot #43.

Star Fill

Create radial turning stitching 
with available stitch types. 
Stitches are generated from 
outside to geometric center. 
Center can be shifted.

Wave Fill
Create contoured stitches along 
a digitized guideline – stitching 
maintains uniform density.

Elastic Fancy 
Fill

Create fancy fill patterns that 
follow stitch angles and are 
scaled according to object 
width. Right-click for settings.

3D Globe 
Effect

Create contoured stitches to 
produce a 3D appearance. 
Choose from pattern library.

Select Object
Click to select objects or drag a 
selection marquee to enclose.

Polygon 
Select

Select irregular areas or shapes 
– click reference points to 
demarcate.

Reshape 
Object

Reshape selected embroidery 
and lettering objects.

Size +10% Increase/reduce size of 
selected object/s in 10% 
increments. Stitches are 
automatically recalculated.Size -10%
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Travel toolbar

This toolbar contains tools for checking a 
design’s stitching sequence by ‘traveling’ 
through it by stitches, colors or objects. 

Zoom toolbar

This toolbar includes tools for zooming and 
panning designs. Other zoom presets are 
available via the View menu. 

Mirror X
Flip selected object/s in 
horizontal or vertical planes.

Mirror Y

Rotate Left 
45° Rotate selected objects in 45° 

increments to right or left.Rotate Right 
45°

Rotate selected objects by 
specified amount – positive or 
negative – in degrees.

Skew selected objects by 
specified amount – positive or 
negative – in degrees.

Enter specific settings for 
precise positioning of selected 
objects. Use in conjunction with 
Rulers & Guides.

Scale objects or whole designs 
by a precise width or height, or a 
percentage factor. 

Use Aspect Ratio button to 
maintain proportions.

Rotate Hoop 
Left 15°

Rotate the hoop and/or hoop 
template, or currently selected 
hoops in multi-hooping mode, in 
15° increments to left or right.

Rotate Hoop 
Right 15°

Rotate the hoop and/or hoop 
template, or the currently 
selected hoops in multi-hooping 
mode, by specified amount – 
positive or negative – in 
degrees.

Select While 
Traveling

Toggle on to select stitches, 
objects, or colors while traveling 
through a design.

Travel 
Backward

Travel backwards through a 
design. 

Travel 
Forward

Travel forwards through a 
design. 

Jump by 
Object

Travel to the previous or next 
object in the design. Use in 
conjunction with Forward/Back 
buttons.

Jump by 
Color

Travel to the previous or next 
color block in the design. Use in 
conjunction with Forward/Back 
buttons.

Jump to 
Start/End

Travel to the start or end of the 
design. Use in conjunction with 
Forward/Back buttons.

Zoom 
1:1

Show design at actual size. Shortcut 
<1>.

Zoom to 
Fit

Display whole design in workspace. 
Shortcut <0>.

Zoom
Left-click to zoom in, right-click to 
zoom out, or drag a ‘zoom box’. 
Shortcut <B>.
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Color Film toolbar

This toolbar is available in the Color Film 
docker in Embroidery Canvas mode.

Embroidery Canvas toolboxes

The Embroidery Canvas workspace contains 
a dedicated Toolboxes area permanently 
docked to the left of the workspace. This 
contains a series of toolboxes organized as 
follows...

Zoom Scale: Select a preset zoom 
scale from the droplist or key in your 
own and press Enter. Predefined 
scales may appear:
• To Fit
• To Selected
• To Article
• To Hoop

Pan
Pan across the workspace by 
dragging. Useful at high zoom 
factors. Shortcut <P>.

Show 
Objects

View individual objects in order 
of stitching sequence. Drag and 
drop object icons to 
resequence.

Back / 
Forward 1 
Object

Move selection back / forward 
one object in the stitching 
sequence.

Back / 
Forward 1 
Color

Move selection back / forward 
one color in the stitching 
sequence.

Move to Start 
/ End

Move selection to start / end of 
stitching sequence.

Sequence by 
Selects

Resequence objects in order of 
selection.

Sequence by 
Color

Resequence all blocks of like 
color. (To maintain separate 
color blocks, use Color Film.)
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Edit toolbox

This toolbox contains all tools you need to edit 
embroidery designs in Embroidery Canvas 
mode.

Auto-Digitize toolbox

This toolbox contains all tools required for 
auto-digitizing artwork in Embroidery Canvas 
mode. 

Add Holes Cut holes in filled objects.

Remove 
Holes

Remove holes from selected 
objects.

Add Stitch 
Angles

Add stitch angles to closed 
objects with or without holes. 
Right-click for settings. 

Remove 
Stitch Angles

Remove stitch angles from 
closed objects with turning 
stitches.

Double Run
Reinforce outlines, stitching in 
reverse direction to the original. 
Shortcut <Ctrl>+<B>.

Blackwork 
Run

Automatically sequence 
selected outlines for efficient 
stitchout.

Branching
Automatically sequence and 
group selected embroidery 
objects. Shortcut <I>.

Apply 
Closest Join

Join selected objects at the 
closest point. Re-apply closest 
join after editing. Shortcut <J>.

Color 
Blending

Create blended stitching in 
selected objects.

Fill Holes
Fill holes in selected objects 
with current stitch type.

Outlines & 
Offsets

Create outlines and offsets of 
any type for any embroidery 
object, open or closed.

Quilting 
Background

Create ‘echo’ quilting blocks.

Create 
Trapunto 
Outlines

Use in conjunction with raised 
satin to create stitching for a 
raised ‘quilted’ look.

Break Apart

Split monograms, appliqué, 
lettering, and blackwork runs 
into component objects for 
editing.

Remove 
Overlaps

Remove unwanted stitching 
from underlying objects or 
lettering.

Weld
Merge selected overlapping 
objects into a single ‘flattened’ 
object.

Knife
Cut objects along a digitized 
line, preserving stitch settings 
and colors in resulting objects.

Stitch Edit
Place the stitch cursor at a 
selected insertion point. 
Shortcut <E>.

Insert Artwork Same as File > Insert Artwork.

Crop 
Background

Open Crop toolbar to crop 
bitmap artwork for use with 
auto-digitizing. 

Adjust Bitmap
Adjust image effects, 
brightness and contrast in 
preparation for auto-digitizing.
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Digitize toolbox

This toolbox contains all tools required for 
manually digitizing embroidery designs in 

Embroidery Canvas mode. Right-click to 
access properties. 

Touch Up 
Bitmap

Edit images in a third-party 
graphics application.

Color 
PhotoStitch

Automatically turn 
photographs and other bitmap 
artwork into multi-colored 
embroidery. 

PhotoSnap

Automatically create rows of 
single-color satin stitching from 
photographs and other bitmap 
artwork.

Prepare 
Bitmap

Prepare bitmap artwork for 
automatic digitizing.

Auto-Digitize
Automatically digitize prepared 
bitmap artwork.

Instant 
Auto-Digitize

Automatically digitize bitmap 
artwork instantly.

Magic Wand
Automatically digitize filled 
areas in bitmap artwork.

Magic Wand 
Block 
Digitizing

Digitize narrow column artwork 
shapes with satin stitch. 

Magic Wand 
Fill without 
Holes

Digitize large artwork shapes 
with Step Fill, ignoring any 
holes within. 

Magic Wand 
Centerline

Digitize centerlines in arwork 
with outline stitches. 

Color 
Matching 
Method

Assign image colors to the 
color palette, or automatically 
match them to actual threads.

Open Object
Digitize open embroidery 
objects.

Closed 
Object

Digitize closed embroidery 
objects.

Open 
Freehand

Draw embroidery outlines 
onscreen in the current stitch 
type.

Closed 
Freehand

Draw closed embroidery 
objects onscreen in the current 
stitch type – outline or fill.

Block
Digitize columns with turning 
stitches.

Ellipse
Digitize ellipse or circle 
embroidery objects.

Rectangle
Digitize rectangle or square 
embroidery objects. Press 
<Ctrl> to constrain.

PunchWork

Create felting objects and 
designs for use with the 
BERNINA Rotary Hook Punch 
tool.

Buttonhole
Digitize a single buttonhole with 
all necessary stitching.

Buttonholes
Digitize a line of buttonholes 
with all necessary stitching.

Pattern 
Stamp

Place individual patterns in the 
design. Choose from pattern 
library.
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Freehand settings

When Freehand tools are activated, the 
Freehand Settings toolbar appears.

Lettering/Monogramming toolbox

The Lettering/Monogramming toolbox 
contains all the tools needed to create 
top-quality lettering quickly and simply. 
BERNINA V9 provides a large range of scalable 

closest-join font styles and multi-color and 
fancy stitching fonts to choose from. 

Appliqué toolbox

This toolbox provides tools for creating 
closed-object appliqué, partial cover appliqué, 
as well as open-object appliqué. 

Basting 
Stitch Marker

Insert a reference marker at 
any angle and position.

Insert 
Graphic 
Marker

Insert a graphic marker 
representing adhesive stickers 
attached to the fabric to 
indicate location and 
orientation.

Use the Smoothing control to specify, as 
a percentage, how closely the smoothed 
outline follows the original.

Use Show Guide to toggle freehand 
digitizing guide cursor – provides more 
control over ‘freehand’ drawing than the 
default pointer.

Use the Guide Inner Circle Radius 
control to define size of center circle of 
freehand digitizing guide.

Use the Number of Guide Circles control 
to set number of circles in the freehand 
cursor – if the inner circle radius is 2mm, 
each additional guide circle is offset by 
2mm.

Lettering
Create embroidery lettering 
directly on screen. 

Monogram- 
ming

Create personalized 
monograms using a selection of 
predefined styles, border 
shapes and ornaments.

Keyboard 
Design 
Collection

Toggle Keyboard Design 
Collection docker display. Use it 
to create, edit and manage 
keyboard design collections.

Digitize 
Appliqué

Digitize closed-object appliqué 
with all necessary stitching.

Digitize 
Appliqué with 
Holes

Digitize closed-object appliqué 
with all necessary stitching with 
multiple boundaries.

Convert to 
Appliqué

Use to convert selected closed 
objects into individual appliqué 
pieces.

Advanced 
Appliqué

Generate open-object appliqué 
from one or more source 
objects.

Remove 
Overlaps

Remove unwanted stitching 
from underlying objects or 
lettering.

Remove 
Appliqué 
Overlaps

Remove unwanted stitching 
from underlying appliqué 
objects. 
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CutWork/StumpWork toolbox

The CutWork/StumpWork toolbox contains 
all tools necessary to digitize cutwork holes and 
pieces from scratch. 

The toolbox also contains all tools necessary to 
create stumpwork from cutwork objects. 

Mirror-Merge toolbox

This toolbox contains all tools required to 
duplicate and transform selected embroidery 
objects in vertical and horizontal planes. 

Combine 
Appliqué

Break apart appliqué into 
component objects and 
recombine and resequence for 
efficient stitchout.

Break Apart

Split monograms, appliqué, 
lettering, and blackwork runs 
into component objects for 
editing.

Export 
Cutting File

Export object shapes to SVG or 
EXP file for cutting machine or 
BERNINA embroidery machine 
with the CutWork tool.

Add Cutwork 
Border

Generate a cutwork border 
from selected objects.

Digitize Open 
Cut

Digitize a simple open cut in 
hooped fabric.

Digitize 
Closed Cut

Digitize a simple closed cut in 
hooped fabric.

Digitize Piece
Digitize a cutout piece in 
hooped fabric, together with 
supporting embroidery.

Digitize Hole
Digitize a hole in hooped 
fabric, together with 
supporting embroidery.

Digitize 
Wireline

Create a wireline using a 
digitized outline and current 
settings.

Convert to 
CutWork 
Border

Convert selected objects a 
cutwork border.

Cut Closed 
Border

Cut a closed cutwork border 
and leave an opening for wire 
ends.

Cut 
Buttonhole Slit

Generate a cutting line for 
selected buttonholes.

Combine 
Selected

Combine cutting lines of 
selected cutwork objects for 
optimized cutting.

Un-combine Reverse ‘Combine Selected’.

Create 
Stumpwork 
Sub-design

Create stumpwork sub-design 
from selected cutwork piece 
borders and included 
embroidery objects.

Open 
Stumpwork 
Sub-design

View and edit selected 
stumpwork sub-design.

Export 
Stumpwork 
Sub-design As

Save stumpwork sub-design 
as a separate design file.

Mirror-Merge 
Horizontal

Duplicate & mirror horizontally 
and merge overlapping 
objects (optional).

Mirror-Merge 
Vertical

Duplicate & mirror vertically 
and merge overlapping 
objects (optional).
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Layout toolbox

The Layout toolbox allows you to arrange 
multiple embroidery designs or design 

elements on a fabric, garment, or item such as 
tablecloth. 

Mirror-Merge 
Horizontal & 
Vertical

Duplicate & mirror selected 
objects around a center point.

Array

Duplicate designs, such as 
badges, automatically 
re-sequencing color blocks for 
efficient multiple design 
stitchouts. 

Reflect
Duplicate and mirror objects 
or designs. Use to create 
decorative borders. 

Rows Define number of rows and 
columns required for Array or 
Reflect.Columns

Wreath

Duplicate selected objects 
around a central axis. Specify 
duplicates in Mirror-Merge 
Settings toolbar.

Enter number of wreath 
points. Enter even number to 
activate Mirror Alternate.

Layout to 
Rectanglar 
Work Area 
Corners

Automatically create copies 
of any selected object/s in 
each corner of the layout 
work area.

Layout Around 
Circular Work 
Area

Automatically create copies 
of selected object/s (specified 
by number of repeats) around 
the center of the work area.

Auto Center to 
Work Area

Automatically move selected 
object/s to center of the work 
area. 

Define Work 
Area

Open the Define Work Area 
dialog to define either a 
rectangular or round work 
area of a specified size. 

Layout to 
Rectanglar 
Quilt Block 
Corners

Automatically create copies 
of any selected object/s in 
each corner of the layout quilt 
block. 

Auto Center to 
Quilt Block

Automatically move selected 
object/s to center of the quilt 
block. 

Auto Fit to 
Quilt Block

Automatically fit selected 
object/s to the quilt block. 

Define Quilt 
Block

Open the Define Quilt Block 
dialog to define quilt block of 
a specified size and a 
specified center. 
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Arrange toolbox

This toolbox contains all tools you need to 
precisely align and distribute objects in 
Embroidery Canvas mode. 

Multi-Hooping toolbox

The Multi-Hooping toolbox allows you to 
specify multiple hoopings manually or 
automatically for large designs. 

Group
Combine multiple objects into 
one selectable object grouping.

Ungroup
Split object grouping into 
component objects.

Lock
Lock selected object/s into 
position for protection.

Unlock All
Unlock all locked object/s to 
remove protection.

Align Left
Align left edges of selected 
objects.

Align 
Centers 
Vertically

Vertically align centers of 
selected objects.

Align Right
Align right edges of selected 
objects.

Align Top
Align top edges of selected 
objects.

Align 
Centers 
Horizontally 

Horizontally align centers of 
selected objects.

Align Bottom
Align bottom edges of selected 
objects.

Align 
Centers

Align centers of selected 
objects.

Space 
Evenly 
Across

Evenly distribute three or more 
selected objects horizontally.

Space 
Evenly Down

Evenly distribute three or more 
selected objects vertically.

Select a Hoop Show hoop properties. 

Automatically 
Add Hoops

Add hoops automatically to 
cover the entire design. 

Add Splitting 
Line

Digitize one or more guides in 
a multi-hoop layout to split 
objects between hoopings.

Preview 
Hoopings

Calculate object distribution 
and registration marks for 
given hoop positions. Display 
thumbnails in docker. Click to 
view each hooping.

Calculate 
Hoopings

Calculate hoopings resulting 
from current layout.

Multi Hooping 
Options

Access workspace options for 
multi-hooping.

Add Hoop
Add a new hooping to a 
multi-hooping layout.

Delete Hoop
Remove selected hoop from 
hooping layout.

Add Hoop 
Right

Place a new hooping to right 
of selected hoop. Allows a 
10mm overlap between 
sewing fields.

Add Hoop Left

Place a new hooping to left of 
selected hoop. Allows a 
10mm overlap between 
sewing fields.
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Applications toolbox

In addition to CorelDRAW®, BERNINA V9 
includes a number of ancillary applications 
which can be launched from the Applications 
toolbox.

Embroidery Library tools

The built-in Embroidery Library provides an 
efficient way to view and manage embroidery 
designs. It recognizes all design file formats 
used by the software. 

Standard (Manage Designs) toolbar
The Standard (Manage Designs) toolbar 
contains standard Windows functions for file 
opening and copy/paste.

View (Manage Designs) toolbar
The View (Manage Designs) toolbar contains 
functions for quick search, sort, and location of 
designs on your company network.

Add Hoop 
Down

Place a new hooping to below 
the selected hoop. Allows a 
10mm overlap between 
sewing fields.

Add Hoop Up

Place a new hooping above 
selected hoop. Allows a 
10mm overlap between 
sewing fields.

Add 4 Hoops 
Around

Generate 4/8 hoopings 
around a selected hoop’s 
perimeter. Allow a 10mm 
overlap between sewing field. 

Add 8 Hoops 
Around

Cross Stitch
Launch BERNINA Cross Stitch 
from within BERNINA V9.

Quilter
Launch BERNINA Quilter from 
within BERNINA V9.

New Blank 
Design

Create a blank design. Shortcut 
<Ctrl>+<N>.

Open 
Design

Open an existing design. Shortcut 
<Ctrl>+<O>.

Open 
Recent 
Designs

Open a design from the most 
recently used.

Cut
Cut selection and place on 
Clipboard. Shortcut <Ctrl>+<X>.

Copy
Copy selection and place on 
Clipboard. Shortcut <Ctrl>+<C>.

Paste
Paste contents of Clipboard into 
workspace. Shortcut <Ctrl>+<V>.

Layout
Toggle the navigation pane, 
details pane, and/or preview pane 
display.

Keyboard 
Design 
Collection

Toggle Keyboard Design 
Collection docker display. Use to 
create, edit and manage 
keyboard design collections.

Change 
view

Change current view of design 
lists.
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Manage Designs toolbox
The Manage Designs toolbox makes it 
possible to search, sort and browse all 
embroidery designs on your system.

Group by
Group the current list of designs 
by selected property and sort 
order.

Sort by
Sort the current list of designs by 
selected property and sort order.

Showing
Filter the current list of designs by 
file type. 

Search
Filter designs based on specified 
search criteria – e.g. stitch range.

Ascending 
order Sort designs in ascending or 

descending order. Descending 
order

New from 
Selected

Create new design(s) based 
on design(s) selected in 
Embroidery Library.

Open 
Selected

Open design(s) selected in 
Embroidery Library.

Convert 
Selected 
Designs

Convert design selected in 
Embroidery Library to different 
machine file types.

Stitch 
Selected 
Design

Stitch out design selected in 
Embroidery Library.

Send Selected 
Design To 
BERNINA 
WiFi Device

Send selected design to a 
named BERNINA WiFi 
Device.

Print Selected
Print design selected in 
Embroidery Library.

Print Selected 
to catalog

Print selected designs to a 
catalog.

Export 
Designs List

Export a text or CSV file 
containing a list of the visible 
design files and their 
properties.

Find 
Embroidery 
Designs

Search computer or network 
for folders containing 
embroidery files to add to 
Embroidery Library.

Add Folder to 
Library

Add folder to Embroidery 
Library to enable faster 
searching and filtering.

Remove 
Folder from 
Library

Remove folder from 
Embroidery Library. This only 
removes the link from within 
the library.
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Keyboard shortcuts

You select commands in BERNINA V9 as other 
MS Windows® applications – from menus or 
toolbars. Keyboard shortcuts are available for 
frequently used commands.

Key combinations
To use a keyboard shortcut, or key 
combination, you press a modifier key together 
with a character key. For example, pressing the 
Ctrl (Control) key with the ‘c’ key copies 
whatever is currently selected – text, graphics, 
etc – to the Clipboard. This is also known as the 
Ctrl+C key combination, or keyboard shortcut.

Windows to Mac conversion
Key combinations are slightly different from 
Mac to PC. If you know and use keyboard 
shortcuts regularly in Windows, you will need to 
retrain your fingers slightly. For the most part, 
a Control + Key in Windows translates to a 
Command + Key in Mac OS. Most favorites 
should work by just making this switch. Here is 
a basic breakdown of keyboard equivalence:

Note  Standard MS Windows® Alt key 
shortcuts apply. Use the Alt key with the letter 
underlined in the menu. To cancel an operation, 
press Esc twice.

General functions

View designs
Windows Mac

Control (Ctrl) Command (most of the time); 
Control

Alt Option

Windows / Start Command / Apple

Backspace Backspace

Delete Delete

Shift Shift

Enter Enter

Return Return

To Press

Cancel command E

Exit the program A+4 

Open existing design C+o 

Print design C+p 

Save design C+s 

Start new design C+n 

To Press Or

Center current stitch c 6 

Measure M

Refresh screen r 4 

Show needle points . (period or full stop)

Show previous view V 5

Show selected objects only V+S

Zoom to fit 0 (zero) 2 

Windows Mac
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Select objects

Edit designs

View stitching sequence

Show/hide connectors V+C

Show/hide picture d 

Show/hide vectors V+d

Pan P

Turn on/off Artistic View T

Zoom (box) b then [ 8 

Zoom factor f 3

Zoom in 2x z [ wheel

Zoom out 2x V+z 0 

Zoom to 1:1 scale (100%) 1 

Vertical scroll A+[ wheel

Horizontal scroll C+[ wheel

To Press

Activate Select Object tool o 

Add next object to selection C+T 

Add previous object to selection C+V+
T 

Deselect all objects E or x 

Select a range of objects V+[

Select all objects C+a 

Select multiple objects C+[

Select next object T 

Select object underneath 2+[

Select previous object V+T 

To Press Or

To Press

Delete the last input point * B

Finish digitizing an object * R or s

Turn underlay on/off u 

Display the lettering dialog a 

Redo command C+y 

Undo command C+z 

Cut selection C+x 

Copy selection C+c 

Paste selection C+v 

Duplicate selection C+d 

Clone selection ]+:

Reinforce outline (Double Run) C+b

Apply branching I 

Delete selection D 

* BERNINA DesignerPlus only

To travel
Press

Keyb’rd Keypad*

1 segment backward C+l 

1 segment forward C+r 

1 stitch backward † l 4

1 stitch forward † r 6

10 stitches backward † t 8

10 stitches forward † b 2

* Num Lock OFF † Select Object tool OFF
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Digitizing & lettering

Manipulate objects and stitches

System shortcuts
Here is a list of commonly-used Windows 
keyboard shortcuts and their Mac equivalents.

100 stitches backward - 

100 stitches forward + 

Activate Stitch Player V+r

To next color d 9

To next object C+t 

To next selected object T

To previous color u 3

To previous object V+t 

To previous selected object V+T

To the end of a design e 1

To the start of a design h 7

To Press

Delete the last input point * B 

Finish digitizing an object * R or s

Turn underlay on/off u 

Display the lettering dialog a 

* BERNINA DesignerPlus only

To Press or click

Nudge selected designs t b l r 

† Use Alt+Drag with BERNINA Quilter * BERNINA Quilter only

To travel
Press

Keyb’rd Keypad*

* Num Lock OFF † Select Object tool OFF

Move an object horizontally 
or vertically

:+C
Drag the object

Maintain an object’s 
proportions while resizing 

† VL+:
Drag corner handle

Reshape selected object h

Change reshape node type [+M 
Select reshape node 
and press spacebar

Group selected objects C+g 

Ungroup selected objects C+u 

Regroup ungrouped objects * C+R

Lock selected objects K

Unlock selected objects V+K

Bring object to front * V+u

Bring object forward * u

Send object to back * V+d

Send object backward * d

Activate Stitch edit e 

Action Windows Mac

Backwards delete Backspace Delete

Capture entire 
screen to Clipboard

Print Screen Command + 
Control + Shift 
+ 3

Capture frontmost 
window

Alt + Print 
Screen

Command + 
Shift + 3

To Press or click

† Use Alt+Drag with BERNINA Quilter * BERNINA Quilter only
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Mac environment on virtual machines
If you are running BERNINA V9 in a Mac 
environment on a virtual machine (VM), you 
may find that shortcuts don’t work as expected.
Lion uses more shortcuts than Snow Leopard, 
especially for LaunchPad and Mission 

Close current 
window

Control + W Command + 
W

Copy a file/folder Control + drag 
icon

Option + drag 
icon

Copy to Clipboard Control + C Command + C

Create an alias or 
shortcut

Right mouse 
click and select 
Create 
Shortcut

Command + L

Cut to Clipboard Control + X Command + X

Exit a dialog box 
without changes

Escape Escape

Find/Search Control + F Command + F

Force quit a frozen 
application

Control + Alt + 
Delete

Command + 
Option + 
Escape

Forward delete Delete Delete (For 
Mac 
notebooks, 
press the 
Function (fn) 
and Delete 
key)

Get item info or 
properties

Alt + Enter Command + I

Logout current user Windows + L Command + 
Shift + Q

Maximize window Control + F10 None

Minimize windows Windows + M Command + M

New folder Control + N Command + 
Shift + N

Open file Control + O Command + O

Paste Clipboard Control + V Command + V

Action Windows Mac

Print Control + P Command + P

Quit / close a 
program

Alt + F4 Command + Q

Rename a file / 
folder

Select item + 
F2

Select item + 
Enter

Save file Control + S Command + S

Select all items Control + A Command + A

Select more than 
one item in a list 
(non contiguous)

Control + click 
on each item

Command + 
click on each 
item

Send items to trash 
/ recycle bin

Delete Command + 
Delete

Send / receive 
email

Control + K Command + K

Shut down Windows + U + 
U

Command + 
Option + 
Control + Eject

Switch to next 
window

Control + F6 Command + ~ 
(tilde)

Switch to previous 
window

Control + Shift 
+ F6

Command + 
Shift + ~ (tilde)

Toggle through 
open applications

Alt + Tab Command + 
Tab

Type special 
characters

Alt + key Option + key

Undo Control-Z Command-

Action Windows Mac
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Control. The latter has Ctrl arrow left and Ctrl 
arrow right assigned by default. With Parallels 
preferences / keyboard / Enable Mac OS X 
system shortcuts checked, the above 
combinations trigger Mission Control functions 
even from inside the VM. That’s what the 
preference item is for. To avoid this, you can go 
two ways:
 Disable the checkbox in Parallels 

preferences. (This is the easy way, but you 
lose all system keys at once within the VM); 
or

 Remove the assignment of those two 
shortcuts in Mac OS X system preferences / 
keyboard / keyboard shortcuts.

Just chose Mission Control on the left side, then 
you can see the two items on the right side. 
Uncheck them, and you are fine inside the 
Windows VM. There’s no sacrifice unless you 
want to use the shortcuts for Mission Control.
Since Mission Control only makes real fun with 
gestures enabled, most people with 
gesture-capable machines won’t need the 
shortcuts. You could even assign other 
shortcuts to Mission Control if you liked.
There may also be an issue with the Shift key 
in Parallels. Try the following: Click on ‘Virtual 
Machine’. Configure and enable the option 
‘Optimize Modifier key for games’.
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